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Exercises
Besides stand-alone exercises you will successively create four templates: 
tpl.fm paragraph, character and table catalogue
tpl2.fm layout added
tpl3.fm cross references added

tpl4.fm added for second course:¶ and f formats
The result of the first course is a FrameMaker book with 3 chapters and a Table of Contents.
Set up the environment for the exercises on the workstation in the classroom (on the Windows desktop 
only!) or on your laptop (in any directory of your liking) as follows:
\exercises

\input From the installation files
\output From the installation files
\MyStuff Your personal directory to save your work

The following exercises cover both the courses FrameMaker introduction and FrameMaker for scientific 
publications.

Manipulate text............................................................... 2
Quick and ‘dirty’ formatting............................................ 3
Tabulate text .................................................................. 4
Set up paragraph catalogue ............................................ 5
Format table with heading and title................................. 7
Set up tables................................................................... 8
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Create a book from 3 chapters...................................... 18
Expand paragraph catalogue......................................... 19
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Bibliography with EndNote ............................................ 25
Convert FM to HTML ..................................................... 26
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Index for sample book.................................................. 29
Automatic assignment of masterpages ......................... 31
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1 Manipulate text
1 Open \Input\txt_manipulations.fm and save it in your personal directly with name 01.fm
2 Change the sequence of various numbered words (for example 150computers)
3 Reverse the sequence of the paragraphs
4 Search for the numbered words using Wildcard1 ON, pattern “[0-9][0-9][0-9]”)
5 Experiment with the search pattern: add an *, then add a blank, then add a | (located at key 7) 
6 Delete the numbered words (use search and replace) 
7 Undo / redo the last operation (FM until 7.1 knows only 1 undo level)
8 Delete the second paragraph (select a paragraph by triple clicking it)
9 Move the bold text in Fourth paragraph to the end of the paragraph.
10 Delete the second lower case L in some words (difficult to select with mouse, use arrow keys)
11 Apply spell checking starting after the heading2 below (read in the handout)
12 Hyphenate the word “super-cali-fragi-listic-expi-ali-do-cious” at the specified positions. Why will it not 

be recognised, although put into the private dictionary?
13 The word network in the Fourth paragraph should not be hyphenated (insert ESC,n,s at the beginning 

of the word (German FM: ESC,k,t).
14 Save your work
Note: Some hints for Mac users can be found in the handout on page A-19.

1.1 FM behaves differently than Word …
First paragraph: Although the main reallm of this network is the corporate internal network (LANs and 
WANs) the role of the Internet is growsing. Hence CBBI is also responsibel for all tasks rellated to the con-
nection of the corporate network with the global Internet.
Second paragraph: Atraxis is connected to other Internet service providers and hence is part of the world 
wide Internet. Atraxis grants acess to both academic and commercial institutions.
Third paragraph: The main feature of the Atraxis Internet service is the conection via the corporate internol 
network. Your PC is not connected directly to the Internet, but to the corporate network, which in turn is 
conected to the Internet.
Fourth paragraph: The 100Internet is more than just a network of 150computers – it is really a network 
of networks spanning the entire globe. 200Beyond that, the Internet is also a network of services and res-
surces, a library, a 300database, and a community of people 400from all walks of life ready to answer 
500questions, listen, and share.
Fifth pargraph: Supercalifragilisticexpialidocious Supercalifragilisticexpialidocious Supercalifragilis-
ticexpialidocious Supercalifragilisticexpialidocious Supercalifragilisticexpialidocious Supercalifragilis-
ticexpialidocious Supercalifragilisticexpialidocious.

1. Deutsch: Jokerzeichen. Das muster gilt ohne die anführungszeichen!



Quick and ‘dirty’ formatting
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2 Quick and ‘dirty’ formatting
1 Open \Input\fmt_quickie.fm and save it in your personal directory with name 02.fm
2 The main heading shall be 14pt Arial, bold, centered.
3 All other paragraphs are 11pt Arial, left adjusted.
4 Set Space above to 6pt (you need the Paragraph Designer for this)
5 Indent the second and third paragraph by 2cm (use the ruler)
6 Make the fourth paragraph italic
7 Save your work

2.1 Formatted text

Klassifizierung der Daten
Die Datenbasis umfaßt drei Klassen von Daten:

Permanente Daten

Permanente Daten beschreiben unveränderliche Merkmale des Systems oder der Vermitt-
lungsstelle. Es handelt sich in der Regel um Initialisierungsdaten. Sie enthalten z.B. die maxi-
male Länge von Datentabellen oder Zustand-Anreiz-Verknüpfungen.

Der Zugriff auf die Datenbasis ist nur an definierten Schnittstellen über spezielle Zugriffsprozeduren mög-
lich. Den Anwenderprogrammen bleibt dabei unbekannt, wie die Daten innerhalb der Datenbasis gespei-
chert sind (Information hidding). Das hat u.a. den Vorteil, daß die Anwenderprogramme von Änderungen
der Datenorganisation unberührt bleiben.

Die Datenbasis wird zentral im Koordinationsprozessor (CP) verwaltet. Daneben sind Kopien bestimmter
Daten auch in den Anschlußgruppen (LTG) und in den digitalen Teilnehmerleitungseinheiten (DLU) vor-
handen. Die Steuerung für Netz der zentralen Zeichengabekanäle (CCNC) enthält eine vom CP unabhän-
gige Datenbasis. Ein Abbild der gesamten Datenbasis (CP und CCNC) befindet sich zur Sicherheit auf
Magnetplatte 

2.2 Terminology

Handle for left indent (first line)

Handle for hanging indent (second to last line)

H ecate est Iovis et Latonae filia, soror 
Apollinis. Est tricopor et triceps, 
magicarum artium magistra ac fasci-
nationum praeses, cinctra latrina.

First

Left Right

Witdth of text frame

Hanging indent = hängender einzug
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E:\FM-course\Exercises\Output\tabulation.fm Exercises, page 4

3 Tabulate text
1 Open \Input\tabulation.fm and save it in your personal directly with name 03.fm
2 Use the formating bar (View > Formatting Bar)
3 Format the sample file table accordingly:
Anzahl right adjusted (flush left)
Artikel left adjusted (flush right)
Stückpreis adjusted to the decimal symbol
Gesamtpreis adjusted to the decimal symbol
The words in the heading shall be adjusted visually pleasing:
4 Save your work

3.1 Result of formatting

Anzahl Artikel Stückpreis Gesamtpreis

45 Ordner 2.0 90.0

5 Hefte 0.90 4.50

100 Füller 2.99 299.

3 Regale 399.0 1197.0

3.2 Hints

Tabulation is absolute in FM, hence behaves differently to the relativetabulation of text processing soft-
ware, such as Word. There are no default positions for TABs in FM.

Double clicking on the TAB symbol opens a 
dialogue to set the properties of a TAB (positi-
on, type, leader dots).
Decimal TAB
Left adjusted TAB

Ruler Tab types and pos.



Set up paragraph catalogue
4 Set up paragraph catalogue
1 Open \Input\fmt-setup.fm and save it in your personal directly with name tpl.fm
2 Define all style names (set up a paragraph style with the name from the paragraph text and apply this 

style to the paragraph)
3 Define all properties for the respective style names (use Update All in the Paragraph Designer)

You may wish to apply a certain paroperty (e.g. Font Family) to a group of selected paragraphs (use 
Apply)

4 Save your work.

Common properties for all paragraph styles:
Language: Schweizerdeutsch
Indent First: 0
Alignment: left

Basic properties Default Font Pagination Numberg.
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1heading page 1.5 1.5 body

Ar
ial

24

bo
ld

Across all co-
lumns and side 
heads

ye
s

<n+>\t

2heading 24pt 1.5 1.5 body 18 In column <n+>\t

3heading 11pt 1.5 1.5 body 14 Side head … <n+>\t

body 5.5pt

Tim
es

 N
ew

 R
om

an

11

In column

nocitation 11pt 1.0 1.0

ita
lic

n1_numbered_1 5.5pt 0.5 0.5 nx_numb... yes <n=1>\t

nx_numbered_x 5.5pt 0.5 0.5

no

<n+>\t

lb_bulleted_list 5.5pt 0.5 0.5 \b\t

tt_table_title 12pt 2.5 2.5

Ar
ial

 na
rro

w

14

bo
ld

<n+>\t

th_table_head 12

tc_table_cell 4pt

10tl_table_list 4pt 0.5 0.5 \b\t

Footnote 4pt 0.5 0.5 9
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Set up paragraph catalogue
4.1 Numbering scheme for titles etc.

4.2 Set up Character catalogue

4.3 Bullet symbols

¶-format Numbering property (watch the spaces inside <...>)

1heading H:<n+>< =0>< =0>< =0>\t

2heading H:<n>.<n+>< =0>< >\t

3heading H:<n>.<n>.<n+>< >\t

tt-table-title H:Table <n>.< >< ><n+>\t

Character
format name

font size weight angle language

1highlight as is as is as is italic as is

2highlight as is as is bold as is as is

computer Courier New as is as is as is none

name Arial 12pt bold regular none

variable as is as is regular italic as is

bullets WingDings as is as is as is none

Wingdings (TT) Zapf Dingbats (T1) Remarks
l (lower L) l (lower L) 1 In dialogue boxes, no „CTRL+q“ sequences 

can be entered. Here the hex notation \x is 
necessary (e.g. \xfc for the cedilla, which 
provides - when formatted with the font 
Wingdings - the desired symbol .

2 For most character formats its essential to set 
only one property. Set the dialog to „As is“ 
with Commands > Set all entries to as 
is. and then set the desired property.

n n

u u

v v

m m

q q

¸ (cedilla), \xfc 4

F +
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Format table with heading and title
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5 Format table with heading and title
1 Open \Input\tables_1.fm save it in your personal directly with name 05.fm
2 At the end of this document insert a table of style A
3 Format the table according to the following sample using the styles provided in the paragraph catalog.
4 Staddle heading and body cells according to the sample
5 Rotate the first column counter clockwise (including the subheading)
6 You will need the Paragraph Designer to align text vetically in a cell (tab “Table Cell”)
7 Apply a Custom Ruling (Table > Custom Ruling & Shading) to the straddled cells of the table body 

according to the sample below (Ruling Style Thick)
8 Save your work

5.1 Hints
The context menu (right mouse button) provides many table functions
To center a cell vertically: Paragraph Designer > tab “Table Cell”
To start a row ‚on next page‘: Table > Rowformat
To specify a row hight: Table > Rowformat
To add a row after the current one: Enter CTRL+RETURN
To select an entire row: CTRL+double click near the right/left border of the cell
To select an entire column (including the heading cells): CTRL+double click in the middle of the cell
To select the entire table: CTRL+triple click anywhere in the table

Table 5.1 Text for table title
head head

he
ad head head head head

Vertically cen-
tered txt in this cell 
please.



Set up tables
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6 Set up tables
1 Opern your template tpl.fm and at the end add a paragraph «Tables» and format it with 2heading
2 For each of the sample tables add a paragraph (bodytext) and insert a table of format A (Table > 

Insert Table…) with 1 Heading Row, the appropriate number of Columns, 4 Body Rows and no Foo-
ting Rows. 

3 Adjust the appearance to the examples below using the Table Designer.
4 Format the paragrphs table heading row with th-table-head and the cell paragraphs with tc-
table-cell.

5 Store the table in the table catalogue with the name provided in the table titles below (e.g. framed_1) 
(use command New Format)..

6 Save your template as tpl2.fm

6.1 Table formats

Note: In the table above no ruling is used except the horizontal lines top, bottom and separator. The 
dotted (gray) lines only demonstrate the cell structure.

Table 6.1 framed_1: 5 x 3.2 cm

Table 6.2 framed_2: 1, 6, 2, 5, 2 cm

Table 6.3 shaded: 5 x 3.2 cm, heading row shaded 10%, 

first cell

second row

third cow

fourth row fifth column



Import text and format table
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7 Import text and format table
1 Create an empty document from your template tpl2.fm and save it in your directory with name 07.fm
2 Import (by copy) \texts\tab_import.txt by copy, as table
3 Convert to a table with 1 (empty) heading row (select your favourite table format)
4 Addd title ‘A Windows 95 log’
5 Insert the title texts into the heading cells.
6 Apply paragraph formats for table (th_..., tc_..., tt_...)
7 Adjust the column widths to make the table use the full text area width (16 cm). Reasonable proportions 

are the widths 4, 3, 7 and 2 cm.
8 You may wish to apply a zebra pattern to the body rows (shading 5%)
9 Save your work 

Table 7.4 A Windows log
Date / time Operation Comment Action
Wed 98-07-01 14:39:05 Starting

Wed 98-07-01 14:59:57 Testing BUTTON COLOURS Restart

Wed 98-07-01 15:00:48 Starting

Wed 98-07-01 15:10:30 Restart (inst) I don’t like that colour scheme mentioned in FrameUsers Restart

Wed 98-07-01 15:11:44 Starting

Wed 98-07-01 16:13:44 Restart (inst) DDD icon in shell32.dll replacing Windows icon Shut down

Wed 98-07-01 16:23:14 Starting

Wed 98-07-01 16:29:20 Application failed Windows 95 Shut down

Wed 98-07-01 16:34:15 Start (hang) ; Termination not possible => HW reset; 

Wed 98-07-01 18:15:06 Testing try again Shut down

Wed 98-07-01 18:23:52 Starting

Wed 98-07-01 18:34:42 Testing icon in user.exe coloured to determine source of startup-icon Shut down

Wed 98-07-01 18:39:59 Starting

Wed 98-07-01 18:41:30 Application failed Well, the icon in the start-button comes from user.exe... but 
not all is ok yet

Shut down

Wed 98-07-01 18:46:47 Start (hang) ; Termination not possible => HW reset; 

Wed 98-07-01 19:00:06 Ordinary close Shut down



Import and format Excel table
8 Import and format Excel table
1 Create an empty document from your template tpl2.fm
2 Save the current file as 08.fm
3 Import (by copy) \texts\inventory(excel9).xls by copy
4 Press Convert at the dialogue Unknown File Type (with Microsoft Excel selected)
5 Press Import at the dialogue Import Text Flow by Copy (leave settings as provided)
6 You get a table, but no chance to select the table format. You may also encounter a console message con-

cerning nonavailable fonts.
7 Both the paragraph where your cursor for the import was and a new one with the table anchor gets the 

format Body*. Format them with your known body. 
8 Place the cursor in the table and open the Table Designer. You will notice a new format name Table.
9 Select table format framed_1 and press Apply.
10 The imported table did not use the heading row(s). You need to convert the first row into a heading row:

-Select the cells of the first row and copy them into the buffer
-Delete the first row (Remove Cells from Table)
-Place cursor in the now first row and select Table > Add Rows or Columns > Add Row(s) to 

Heading.
-Paste the copied cells into the heading row and apply the desired format th-table-head.

11 Apply format tt-table-title to the empty table title and set an appropriate title.
12 Adjust column widths to your liking and apply proper formatting to the body cells.
13 You notice incomplete text in some cells of the first column: the maximum hight of the row is not set. 

Select the first column and remove this restriction with Table > Row Format… and setting the mini-
mum to 0 and the maximum to 5cm.

14 Save your work

8.1 The imported and formatted table

Table 8.1 Inventory at the start of self employment
date # ob-

jects
unit price price (new)

PC pentium: 16MB, 1GB, tape, CD-ROM, sound-card, SCSI, 
keyboard, mouse

Dec-94 1  8,000  8,000

21" screen colour Aug-95 1  3,500  3,500

Modem Dec-94 1  500  500

Printer HP: 10MB, duplex, large bin Feb-95 1  6,000  6,000
E:\FM-course\Exercises\Output\Excel_import.fm Exercises, page 10



Import and format Excel table
FAX / phone / answering Jun-95 1  500  1,000

Scanner Feb-92 1  2,000  2,000

Macintosh IIsi, 17MB, 21" BW screen, 15" colour screen, Sy-
quest cartridge

Feb-92 1  5,000  5,000

Bookbinding: hot-melt-glue, drill, spiral binding Feb-92 3  800  2,400

Paper cutter (goillotine) Jan-82 1  1,500  1,500

Desk (2 drawers) Feb-85 1  800  800

Plates on desk and drawers May-95 5  100  500

Shelves metal and plywood May-95 12  40  480

Office materials, paper, toner, writing etc. Jan-95 50  25  1,250

Office drawers for small materials and paper Apr-93 5  120  600

Books, special literature various 280  80  22,400

CD-ROM with data (not SW) Feb-95 10  120  1,200

PC software (Frame, MS-Office, utilities, Visual Basic, PageMa-
ker, Designer, Robohelp, Administration...

Mar-95 10  1,200  12,000

Mac software (Frame, Word, Excel, PageMaker, Illustrator, Pho-
toshop, ...

Feb-92 8  1,200  9,600

Storage media (diskettes, tapes, cartridges) May-94 20 50  1,000

Fonts Mar-93 10 400  4,000

Spare for near future Dec-95  1,270

Sum  85,000

Table 8.1 Inventory at the start of self employment
date # ob-

jects
unit price price (new)
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Importing graphics
9 Importing graphics
1 Create an empty document from your template tpl.fm and save it in your directory as 09.fm
2 At the end of the line with a file-name import this graphic with File > Import > File.
3 Select a reasonable size by specifying an appropriate resolution for bitmap formats (jpg, tif, gif).
4 You get a surrounding anchored frame with default properties automatically.
5 Resize the frame with the eye to 16cm widht and 4cm height and specify it left adjusted (Special > 

Anchored Frame).
6 Copy the eye image and then paste it into the same frame into the top right top corner.
7 Enlarge the left image by setting the resolution to 72 dpi. The image will be cropped at the bottom by the 

anchored frame.
8 Save your work
Import Input\graphics\auge.jpg

Import Input\graphics\hadron321.tif

Import Input\graphics\gis-switchgear.eps (60%, frameheight 30 mm, image at bottom)
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Importing graphics
Some PNG files add a huge number of colour defintions of the form RGB xxx,xxx,xxx to the colour catal-
goue.
This file (\Output\Graphics\photo_1.png) does not alter the colour catalogue:

This file (\Output\word\Graphics\24-pict5.png) adds lots of these colour definitions:

You can not get rid of these pseudo colour definitions. Not even the script Remove unused Colours by 
Klaus Müller really removes them from the colour catalogue.
The difference of these two files is only the pixel depth:

With 8 bit pixel depth (256 colours) you get the problem
With a full colour PNG (24 bit pixel depth, 16 million colours) FM works fine.
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Create a graphic with Frame tools
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10 Create a graphic with Frame tools
1 Create an empty document from your template tpl.fm and save it in your personal directory as 10.fm.
2 Create a paragraph style fig-text with the same properties as tc_table_cell, but centred and 

other things you might like.
3 Remember that a graphic should be set up within an anchored frame (size about 12 x 8cm) to float with 

the text.
4 Apply a border of minimum thickness to the frame.
5 For the text inset use a text frame and apply a shade of 10% black to it. Format this text with fig-text.
6 For the short reference texts you may use the graphic text tool (A) or also small text frames with no border
7 Group everything inside the frame to avoid accidently moving items.
8 Save your work.

10.1 Hints
Set the appropriate grid spacing for the snap function (View > Options > Grid Spacing). 1mm is a 
good choice.
When using the te Text Line tool you can only apply character formats, for example, name.
You may wish to define a character style fig-text with font properties of the paragraph style tc-
table-cell.
Use Alt+Arrow to move an object pixel by pixel, Shift+Alt+Arrow for 6pixels.
Also short texts can be placed in (small) Text Frames. This provides the greatest flexibility for format-
ting.

This is the ultimate non-
sense diagram for the 
sole purpose of demon-
strating some featues of 
FrameMaker and friends.

DHCP

FA REC C REC LTG

DB CC DB LTG
Recovery

DEP
3

1 2

4 5

6



Set up the layout
11 Layout for the sample book
1 Create an empty document from your template tpl.fm and 

save it as tpl2.fm

11.1 Set up the layout

11.1.1 Layout for doub-
le sided docu-
ment

2 Start with a one-sided document (right page) with the meas-
ures shown above.

3 For the main flow (A) define Room for Sideheads = 5 cm and 
Gap = 0.5 cm

4 Define the header and footer areas

5 Set paragraph styles in all frames on the master page to body.

6 Specify the document as double sided (Format > Page Layout 
> Pagination)  this creates a Left master page

7 Mirror the margins for the Left master page

11.1.2 Graphic on left 
master page

8 On the Left master page arrange a text area (4 mm high), ori-
ented from bottom to top on the inner margin. Start the 
frame horizontally and rotate…

9 To get the logo image on the page, click outside any frame on 
the page, then import by copy \graphics\ifp_logo_18x42.tif 
with a resolution of 400 dpi; rotate the image and adjust its 
position.

10 Save your work as tpl2.fm
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Refine the layout
11.2 Refine the layout
11.2.1 Modifications to 

paragraph styles
11 Add a ¶-format z-header (based on body). You may wish to 

define another fontsize for this format.

12 Add a ¶-format z-footer (based on body). Define a right TAB 
position 18 cm. You may wish to define another fontsize for 
this format.

11.2.2 Running footers
Footers on both

master pages
13 Apply format z-footer to the paragraph in the footer frame

14 Place the page number (a system variable) on the outer mar-
gin. Set up the page number in the form

<$chapnum> - <$currpagenum>

Footer on the Left
master page

15 Place the full file name (building block <$fullfilename>) on 
the inner margin.

Footer on the Right
master page

16 Place the current date in the ISO format (yyyy-mm-dd) on the 
inner margin.Build this format based on the system variable 
Modification Date (short) with the building blocks

<$year>-<$monthnum01>-<$daynum01>

11.2.3 Running headers
Header on both

master pages
17 Apply format z-header to the paragraph in the header frame.

Left master page 18 Insert system variable Running H/F 1 and change the defini-
tion form [Heading1] to [1heading].

Right master page 19 Insert system variable Running H/F 2 referring to 2heading.

11.2.4 Additional work 20 Define user variables author and institution with adequate 
contents and apply the character format 1highlight to you 
second name. Add a non-highlighted term (for example, loca-
tion).

21 Place the variables into the vertical area, separated by a 
comma or semicolon.

22 Save your work (tpl2.fm)

11.3 Hints
In variables, crossreferences etc. character formats are repre-
sented as <formatname>, for example <1highlight>. 

In variables, cross reference formats etc. the building block 
<Default ¶ Font> can be replaced by the shorter </>.
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Create the first chapter
12 Create the book chapters
1 Copy the complete directory \Input\book\ to your personal 

directory.

12.1 Create the first chapter
2 Create an empty document from your template tpl2.fm and 

save it in your book-directory as 1ressourcen.fm

3 Import (by copy) \book\1ressourcen.txt as text and apply the 
formats (styles) to the paragraphs according to the following 
scheme:

4 Convert the paragraphs between

--- table --- and
--- end of table ---

to a table and format accordingly. Use 1 heading row for the 
conversion.

5 Delete the line introducers -- with the Find/Replace dialogue 
using wild cards and the pattern ^--

12.1.1 Final work 6 Place some cross references to 3heading elsewhere in the 
chapter. Use a reference format 
<$paratext> auf Seite\ <$pagenum>

7 Create the cross reference to an existing footnote. You may 
need a character format super defining superscripting.

8 Insert the graphics into the table (\book\thumb1.tif etc.)

9 Place the photo as background images (or if you want, with a 
run-around property) at the beginning of the text.

10 Import your changes (cross-reference) to the template (tpl2) 
and save the template now as tpl3.fm

Line starts 
with

Format this paragraph as 

$, $$, $$$ Heading level according to the number of $
There is only one 1heading per file / chapter

-- bulleted or numbered list

The following will be demonstrated one at a time

--- Table

## Footnote reference. The corresponding footnote text follows

# ... # Footnote text

??? Format this with ¶ format citation

!! ... !! Cross reference to a footnote
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Create Table of Contents (TOC)
13 Create a book from 3 chapters
1 Chapters 2 and 3 (2thema.fm, 3loesung.fm) are ready for use 

to avoid too much squirrel work. Copy these files to your per-
sonal directory.

2 Define a book (File > New > Book) based on chapter 1 
(1ressourcen.fm)

3 Add chapters 2 and 3 to the book.

4 Save the book as umwelt.book into your book directory.

5 For each chapter set up correct numbering (chapter number, 
page numbering, paragraph numbering…)

6 Update the book (to renumber the items) and verify the chap-
ter numbering.

7 Redesign the format citation in the first chapter with some 
graphic elements above and below and distribute the new for-
mat to your chapters and template files.
The graphic elements are in named graphic frames on the ref-
erence page.

8 Distribute all formats via the book to all chapters.

13.1 Create Table of Contents (TOC)
9 Add a TOC at the beginning of the book (Add > Table of Con-

tents …). There is no contents yet in this file.

10 Specify the 3 heading levels to be used for building the TOC.

11 Update the book to generate the TOC file

13.1.1 Modify the pre-
sentation of the 
TOC

12 For all xxxTOC paragraphs styles define a right tab at 8.7 cm 
with a dot leader.

13 Place a TAB character into the definition lines on the reference 
page TOC in front of the <$pagenum>

14 Update the book to generate the TOC file

13.1.2 Further possible 
modifications

15 Insert the heading numbering in front of the heading (use 
building block <$paranumonly>)

16 You may want to insert additional TAB between numbering 
and heading text.

17 Vary Space above and indentation for the xxxTOC paragraph 
styles to group items.

13.2 Finally
Zip your work into file and send it by e-mail to yourself or place 
the exercises on a memory stick (input + output approx 14 MB).

 You have successfully mastered the course FrameMaker Intro-
duction.

Congratulations!
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Expand paragraph catalogue
14 Expand paragraph catalogue
Open your tempate tpl3.fm to expand both the paragraph catalogue and the character catalogue. 

14.1 Numbering the additional elements
4heading Although in real life this level would not be numbered, we continue the structure of 

1heading, 2heading, 3heading.
for-formula is numbered at the end of the paragraph, the number surrounded by parantheses and de-

rived from the number of 1heading. No fix line spacing!
fig-figure-title  is numbered similar to the table title, but of course the constant text is “Figure. ” 

14.2 The matrix of the expanded numbering scheme
New elements to be insrted into existing formats are set in bold. 

Basic properties Default Font Pagination Numberg.

Paragraph for-
mat name

sp
ac

e a
bo

ve

in
de

nt
 le

ft 
[c

m
]

ta
b 

L 
[c

m
]

ne
xt

 p
ar

ag
ra

ph

fo
nt

siz
e [

pt
]

we
ig

ht

pa
gi

na
tio

n

ke
ep

 w
ith

 n
ex

t

Nu
m

be
rin

g 
(fo

r h
ea

di
ng

s

4heading 14pt 2 2 body

Ar
ial

12

bo
ld

RunIn yes

see ma-
trix below

for-formula 12pt body 12 In Co-
lumn

no

fig-figure-title 12pt 2.5 2.5 body 14 In Co-
lumn

no

¶-format Numbering property

1heading H:      <n+>< =0>< =0>< =0>< =0>< =0>< =0>\t

2heading H:      <n>.<n+> < =0>< =0>< > < >  < >  \t

3heading H:      <n>.<n>. <n+> < =0>< > < >  < > \t

4heading H:      <n>.<n>. <n+>.<n> < > < >  < > \t

tt-table-title H:Table <n>.< >  < >  < >  <n+> < >  < >  \t

for-formula H:(     <n>.< >  < >  < >  < >  <n+> < >  )

fig-figure-title H:Fig.  <n>.< >  < >  < >  < >  < >  <n+> \t
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Expand paragraph catalogue
14.3 Expand the character catalogue
To handle formuals (equations) FrameMaker needs a character format EquationVariable (English 
FM) or GlgVar (German FM). This has the same properties as the already defined variable format, but 
it must be present in the character catalogue. Set it up!

Save your work in your personal directory as tpl4.fm

Character
format name

font size weight angle language

EquationVariables as is as is asis italic as is
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The Gaussian Bell curve
15 Create and manipulate formulas

15.1 The Gaussian Bell curve
On the alst isue of the 10 DM banknote C. F. Gauss and his famous for-
mula are displayed.
1 Open \Input\formulas.fm and save it in your personal directly 

with name 15.fm
2 Set up the formula in the paragraph below using the euquation palette.
3 Set up the formula in the other paragraph and use as much keyboard in-

put as possible. The following will help you.

15.1.1 Develop the for-
mula using the 
keyboard:

ESC m l
f ( x SPACE SPACE SPACE =
1 / \sigma ENTER
* \sqrt ENTER
2 * \pi ENTER
SPACE SPACE SPACE SPACE * e
SPACE SPACE ^ - ( x - \mu ENTER
SPACE SPACE SPACE SPACE /
2 * \sigma ENTER ^ 2

The Gaussian Bell curve: 

15.1.2 Hint To remove the large parantheses:
Select the construct including the parantheses, then type ESC m r p 
What’s wrong if the formulas overlaps the text paragraphs?

Function / symbol short-cut

New large equation ESC, m, l (lower case L)

Shrink wrap equation ESC, m, p

General function \function

Greek characters \sigma  \pi  \mu

Square root \sqrt

Power, expoment ^ (accent circumflex) a

a. On a Swiss keyboard this is a ‘dead key’, you need to press ^ followed by
SPACE to get the character.

f x( ) 1

σ 2π
---------------e⎝ ⎠
⎛ ⎞

x μ–( )–
2σ2

--------------------
=
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Formula from a CERN paper
15.2 Formula from a CERN paper
In 1984 CERN issued a paper Hadron Properties from QCD Sum Rules 
which was printed using the IBM Document Composition Facility2 with 
the Script Formula Formatter. It turned out that this paper with a huge 
number of formulas was a crash test for the IBM program...
The left part of these formulas are all equally wide - we can align them 
with the alignment function for graphics.

Set up an anchored frame (10 x 5 cm, left)
Enter the formulas either using the keyboard or the equations palette.
Some formulas can be developed from others. Use copy and paste and 
then modify the pasted formula.
Adjust the forumalas to a vertical line and distribute them vertically 
with even space.

15.2.1 Hints For the term left to the equal sign you need both a superscript (ESC, 
m, ^)  and a subscript (shortcut not working on CH keyboards) to the 
base character.
Copying a formula (or part of) requires selection of its content, not sel-
ection as a graphic object. For pasting a formula the target must be a 
selected question mark.

15.2.2 Formulas in 
same frame

2. DCF uses a technique called Generalised Markup Language, developed by Charles Goldfarb, the father 
of SGML.SGML in turn inspired Tim Bernes Lee to develop HTML on these grounds.

CG
V 1

12Q4
---------------- 1– 3J2 1J3–+( )=

CG
P 1

24Q2
---------------- 5 6J1 15J2 J3+–+( )=

CG
S 1

8Q2
------------ 1– 2J1 3J2+ +( )=

CG
A' 1

3
---CG

S=

CG
A 1

4Q4
------------ 1 J2–( )=
2006-08-28 E:\FM-course\Exercises\Output\formulas.fm 13 - 22



Copying and pasting
15.3 Copying and pasting
This picture3 shows two formulas which are nearly identical. The only no-
ticable differeces are the primes.

Define an anchored frame of 11.8 x 7 cm
Develop the first set of formulas (the left part). At the end of a formula 
line enter ESC m b s for a line break (the cursor jumps to the next 
line only after entering something).
Select the four formulas as graphic object and create a copy to the right.
Change the contents of the right hand formulas:
Remove a prime: select it, press Backspace twice.
Add a prime: select the base character and enter the grave accent.

15.3.1 Formulas in 
same frame

3. Source: Christian Gerthsen, Helmut Vogel: Physik, Ein Lehrbuch zum Gebrauch neben Vorlesungen. 17. 
Auflage, Springer 1993.

x
1

1 β2–
-------------------- x vt–( )

y' y

z' z

t' 1

1 β2–
-------------------- t x

v

c2
------–⎝ ⎠

⎛ ⎞

=

=

=

=

x
1

1 β2–
-------------------- x' vt'–( )

y y'

z z'

t' 1

1 β2–
-------------------- t' x' v

c2
------–⎝ ⎠

⎛ ⎞

=

=

=

=
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Break up long formula
15.4 Break up long formula
The following formula 3.21 from the Hadron paper is awfully long and 
must be broken down into lines.

Insert manual line breaks at the places demonstrated by the picture 
above.
Align lines 2 and 3 of the formula with the operators right to the equal 
sign. (Set Manual: ESC, m, a, s)
You will notice that lines 2 and 3 are automatically aligned after inser-
ting the manual alignment point behind the equal sign.

15.4.1 Formula efore 
breakung up

15.4.2 Formula after 
breaking up

ImδΠ
m1 m2–( )2

q2
--------------------------------

Nc
4π
------- g

2

8π2
-----------C2 F( ) q

2

q2
-------⎝ ⎠
⎛ ⎞2

u2 B u u u,,(⎝
⎛×=

ImδΠ
m1 m2–( )2

q2
--------------------------------

Nc
4π
------- g

2

8π2
-----------C2 F( ) q

2

q2
-------⎝ ⎠
⎛ ⎞2

u2 B u u u,,( ) 1 u+
1 u–
-------------ln–⎝ ⎠

⎛ ⎞ 3
8
---u 45

8
-------u3

3
16
------- 34

16
-------u2 13

16
-------u4–+⎝ ⎠

⎛ ⎞ 1 u+
1 u–
------------- …+ln

+

+

–×

=
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The paragraphs
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16 Bibliography with EndNote
1 Install the D+DD utility FM+EN and start it.4

2 For EndNote use the reference data base Input\ref_lib\nla.enl
3 Use bibliographic output style IEEE
4 Check set up of EndNote for use with FrameMaker (Citation Markers 

with curly braces).
5 Open Input\endnote.fm and save it in your directory as 16.fm
6 Insert citations to the following references at the end ot the sample pa-

ragraphs using copy in EndNote, Paste in FM by CTRL+Y (not V!)5:

- De viris illustribus

- A New Data Type for National Language?

- Veni vidi vici

7 At the very end of the sample book insert a heading to add the biblio-
graphy after it

8 Run the utility FM+EN according to the documentation
9 Copy the generated bibliography from Word and save your work.

16.1 The paragraphs
Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam no-
nummy nibh euismod tincidunt ut laoreet dolore magna [1].
Aliquam erat volutpat. Ut wisi enim ad minim veniam, quis nostrud exerci 
tation ullamcorper suscipit lobortis nisl ut aliquip ex ea commodo [2].
Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse mole-
stie consequat, vel illum dolore eu feugiat nulla facilisis at vero eros et ac-
cumsan et iusto odio dignissim qui blandit praesent luptatum zzril delenit 
augue duis dolore te feugait nulla facilisi [3].

16.2 Generated/copied bibliography
[1] P. D. H. Müller, De viris illustribus, 9 ed. Hannover: Carl Meyer 

(Gustav Prior), 1925.
[2] A. LaBonté, "A New Data Type for National Language?," pre-

sented at SEAS Anniversary Meeting, Amsterdam, The Nether-
lands, 1989.

[3] K. Bartels, Veni vidi vici, 5 ed. Zürich: Artemis Verlag, 1981.

4. A more simple method can only be used until EndNote 8. Starting with version 9 EndNote is UNICODE 
compliant and hence can not work directly with FrameMaker which is not UNICODE capable.

5. The inserted temporary citations must look like [[Daube, 1989 #6]], not like {Daube, 1989 #6}.



The test input
17 Convert FM to HTML
1 Open Input\html-text.fm and save it in your directory as 
17.fm.

2 Save As HTML with File > Save As… > HTML (*.htm)
3 Open the generated files (17.htm, 17.css) in your browser.
4 Modify the generation by entering proper values into the reference 

page HTML in the Headings Table. Modify existing entries with 
File > Utilities > HTML Setup. 

5 Save your work
6 Now genrate the HTML again.
7 Open the generated files (17.htm, 17.css) in your browser

17.1 The test input
This is just something with a copyright symbol © and a registered symbol 
®.
And lets place a footnote here6 and this is superscripted.

17.1.1 Details to step 4 
above

You need to look after every FrameMaker paragraph or chacter tag, becau-
se the default mappings may be very strange. 

Here is a citatation of some length. Here is a citatation of 
some length. Here is a citatation of some length. Here is a ci-
tatation of some length. 

How displays a name, highlight1 and the computer highlight2?.

17.1.2 Options for 
images

In the dialogue HTML Options you can set the image file format for to be 
converted into (GIF, JPEG, PNG). Files already in any of these formats 

6. This is just a footnote to show how it works

Table 17.1Set up the mapping table
FrameMaker tag HTML element
citation Block Quote

numbered list items List Item

2highlight Strong Emphasis

bullets THROW AWAY

computer Code

name Strong Emphasis

variable variable
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The generated HTML
will not be converted. This conversion applies also to FrameMaker inter-
nal graphics.
Click the checkbox Copy Referenced Files , if you want to include re-
ferenced images in the directory where the generated HTML will be sa-
ved.

17.1.3 Some other items Referenced images are copied only on demand (setting options). Copied 
images will be converted to PNG (or else according to options set).

17.1.4 Numbered list The numbers will not be displayed in Opera 8 and Firefox 1, but in IE 6.
1 first item of numbered list
2 second item in numbered list
3 third item - the last one.

17.1.5 Bulleted list Bullets will not be displayed in Opera 8 and Firefox 1, but in IE 6.
first bullet with some long text to show the wrapping in the HTML en-
vironment. some long text to show the wrapping in the HTML environ-
ment. some long text to show the wrapping in the HTML environment. 
second bullet. A short one.

17.2 The generated HTML
The generated HTML file my look strange to HTML coders, abut it serves 
the purpose in many cases. 

Uses a style sheet which tries to mimic the appearance in FM
Is cluttered with many doubled items (e.g. <UL><UL> .... rather than 
<UL> only)
Every paragraph is identified (<A NAME="0_pgfId-
1003672"></A>Set up th…)
The default generation with the export filter can be used as a quick & 
dirty solution, but the export with tools such as WebWorks Publisher is 
much better.
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Hints
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18 Reference to footnote
Open Input\footnote-refs.fm and save it as 18.fm in your own 
directory.
1 Add to the text below at ‘xxx’ at the end of the third paragraph a refe-

rence to footnote 2:
2 The reference should look similar to the ordinary footnote references.
3 Add another refence to the second footnote at ‘yyy’. Define a format 

containing the page-number

18.1 Hints
Name the new reference fomats footnote-ref and footnote-ref-
page.
You need to set up a character format super or superscript
You may abbreviate the building block <Default ¶ Font> to </>

18.2 Sample text
Hecate est Iovis et Latonae filia, soror Apollinis. Est tricopor et triceps, 
magicarum artium magistra ac fascinationum praeses, cinctra latrantium 
canum turma; noctu stans in triviis vel prope sepulcra et ubi loca sunt ca-
edibus contaminata.7

Lorem ipsum feugiat nulla facilisis at vero eros et accumsan et iusto odio 
dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 
feugait nulla facilisi.8

Et tam neque pecun modut est neque nonor et imper ned libidig met, 
consectetur adipiscing elit, this stuff? Bis nostrud exercitation ullam 
mmodo consequet. Duis aute in voluptate velit esse cillum dolore eu fugiat 
nulla pariatur 7.
At vver eos et accusam dignissum qui blandit est praesent luptatum delenit 
aigue excepteur sint occae. Et adipiscing elit, set eiusmod tempor incidunt 
et labore et dolore magna aliquam. Ut enim ad minim veniam, quis nostrud 
exerc 8 on page 28.

7. This is the first footnote on this page and many more may follow
8. This is the second footnote to which you should create additional ref-

erences in the text.



Index markers
19 Index for sample book
1 Have your sample book (umwelt.book) open and all chapters 

where you will insert the index markers.

19.1 Index markers
2 In the chapters of your sample book, set up index markers to get 

entries for following words:
umwelt, biologie, konferenz, symposium

3 Place the index markers both in chapter 1 and 2 at any place you 
like, but distribute the markers across pages.

4 Duplicate some entries on successive pages.

5 Add markers defining synonyms:
umweltschutz => ökologie
symposium => konferenz

6 Add markers defining second level entries:
fauna / fische, fauna / landtiere, lebensraum / 
berge, lebensraum / flachland, lebensraum / 
gewässer

19.1.1 Hints • Look up the marker syntax in the handout

19.1.2 Index generation 7 Add the index to the book (Add > Standard Index…; Add). 
This places a file name in the FM book (but this does not yet exist).

8 Update the book (this will generate the index)

9 From the book enter the index file (umweltIX.fm) and save it. You 
may not be satisfied with the default presentation.

19.2 Modify index presentation
10 In the index file modify the masterpages Right and Left to be dou-

ble column, no margin area, gap between columns 5 mm.

11 Modify the index generation on the reference page IX to get a pres-
entation similar to this:

index entry level 1 ...................... 17
index entry level 2 .............. 23

12 Format the separating characters (GroupTitlesIX) to be sans 
serif, 14 pt and set space before to 12pt.

13 Switch back to the Body pages

14 Got to the book file and update the book.

15 Look at the index file and save it.
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Masterpage Right
19.3 Masterpage Right

19.4 Reference Page IX
SeparatorsIX 1, 2–3

GroupTitleIX Symbols[\ ];Numerics[0];A;B;C;D;E;F;G;H;I;J;K;L;M;N;O;P;Q;
R;S;T;U;V;W;X;Y;Z

SortOderIX <$symbols><$numerics><$alphabetics>

IgnoreCharsIX --–—

Level2IX Level2IX

Level1IX Level1IX

ActiveIX openObjectId <$relfilename>:<$ObjectType> <$ObjectId>

IndexIX <$pagenum>

19.4.1 Hints • Watch the paragraph tags of the various lines on reference page IX.
• The line containing building block <$pagenum> must be preceeded by 

a TAB character to get the leading dots in front of the page numbers.
• Lines Level1IX and Level2IX need right adjusted tab positions.
• Line Level2IX needs a paragraph format with indentation.
• If you want an m-dash for grouped page-numbers, modify line 

SeparatorsIX accordingly.

0.5 cm
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20 Automatic assignment of masterpages
In chapter 2 of the sample book (umwelt.book) we want to place 
large photographs. These should be larger than the whole text 
frame on the standard pages.

In a special masterpage we define a different layout to take the large 
images. The assignment of this master page shall be automatic by a trigger 
paragraph.

20.0.1 Set up special 
master page

1 Create a new master page named big-picture on the base of 
the Left master page, but with different properties:

- No heading and footing

- The main text frame is 20cm wide, 28 cm high and its dis-
tance from left is 0.5 cm, from top 1 cm

2 Create a new paragraph format named image-anchor based on 
bodytext, with the following changes:

- Start on new page

- No space above and below

- Font size 3pt

3 Insert such a paragraph at an appropriate place in the chapter 
and anchor a “Frame below current line” which is 27.5 cm high 
and 19.9 cm wide.

Note: Don’t panic, the paragraph with the anchor will be alone on a 
page and the frame will be on the next page.

4 Import (by reference) an image into the anchored frame and 
resize the graphic to fill the frame.

Note: You can not see the right border of the anchored frame, 
because it will be outside the paper width. This is due to the 
currently improper master page. Hence you need to resize the 
image numerically to the width of the frame.

5 Copy the paragraph with the anchor (which now includes the 
frame and the image) to two other locations in the document.

20.0.2 Set up automatic 
assignment

6 Now set up the automatic assignment of the new masterpage 
with Format > Page Layout > Apply Masterpages ... and press 
OK in the first message.

7 Provide OK also to the next message which announces the cre-
ation of a new mapping table. You will not see any changes in 
the document yet.

8 Open the Reference pages and go to MasterPageMaps. The map-
ping table is still empty. Fill in the following data:

UnstructMasterPageMaps
Book Update (Yes or No): Yes

Paragraph Tag Name Right-Handed Master 
Page (or Single-Sided 
Master Page)

Left-Handed Master 
Page

Range Indicator (Single, 
Span pages, Until 
changed)

Comments

image-anchor big-picture big-picture Single
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Result
9 View the Body pages and Format > Page Layout > Apply Mas-
terpages ... Press OK at the message "All Masterpages will be re-
applied ..." 

10Depending on the speed of your machine You will see some 
flicker on the screen and some activity in the status line: fin-
ito.

20.1 Result

The result should look like Output\2thema-grosses-bild.fm :

Anchor/trigger paragraph
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Create a FrameMaker version
21 Import from Word
Look at the Word example \Input\text\Word-2003.doc . You 
will diagnose the following:

Only styles Heading 1/Überschrift 1 and Normal/Stan-
dard is used for headings, running text and lists. Hence there is ample 
local formatting!
Pictures are inserted directly into the document with two methods: im-
bedded picture (inline shape) and shape. 
The table of contents is a field. Note that the lines are hyperlinks.
Switching on View Formatting Marks (Tools > Options > View) re-
veals lots of empty paragraphs …

21.1 Create a FrameMaker version
1 Set up an emty document from your template tpl3.fm and save it as 
21.fm

Although all advice for Word im-
port state to clean out the Word 
file first, we will do the work in 
FM. For a detailed procedure 
see the handout appendix C.

2 In Word select everything (CTRL+A) and copy to the buffer.
3 In FrameMaker do not just paste, but use Paste Special and select Text. 

This inserts just the text with the format of the current paragraph.
4 Delete all the empty paragraphs and save the document.
5 Walk through the text and join obviously split lines (line breaks some-

times are converted to paragraph breaks). Check for other inconsisten-
cies (e.g. empty paragraphs starting with blank).

6 Apply the appropriate paragraph formats. At the lists you will have su-
perfluous numbering or dashes as well as superfluous TABs.

7 Set a TAB stop at a reasonable position for the ‘TOC’ lines. You may 
wish to create a new ¶ format contentsline for this.

8 Replace the page numbers in the ‘table of contents’ with cross refe-
rences to the headings and an appropriate cross reference format. You 
may wish to create a cross reference format Page # for this.

9 Remove the superfluous numbering and dashes in the lists.
10 In Word select a picture, copy it and paste it into a graphics application 

(for example, PaintShop Pro or PhotoShop), save it as a graphic file 
(photo: jpg; line art:tif; screen shot: png) to your document directory. 
Do this will all the pictures.9

11 Insert the pictures into the FM document by reference (not copy) at the 
appropriate locations and apply the call-out in picture 2.

9. The first 2 images are inline shapes. You will get only 256 colours from them!
You will find that images number 1 and 3 are useless - you will not transfer them.
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Hints
12 Check spelling, check appearance and finish your work. Of course our 
available paragraph formats do not fit well to the task, so you may wish 
to modify appearance or define additional formats.

13 Save your work.

21.2 Hints
1 A quote from the FrameMaker mailing list:

After the import, before you try retagging, you may want to save to MIF 
and open that file in FM. It's pretty well documented that Word's hid-
den control characters often survive an import and can cause all kinds 
of "inreresting" and unexpected behavior. So I think that would be my 
starting point.

2 To remove all empty paragraphs use the wildcard pattern \p\p and re-
place it (repeatedly) with \p.

3 Find the Word numbering with the wildcard pattern ^[0-9].\t
4 Find the dashes in the list with wildcard pattern ^- (  is a blank)..

21.3 Result
Compare your result with Output\word.fm and word-fm.pdf:

MK46-001en-HWRemoteAccessUpkit.fm 1 of 6

ACTION RECOMMENDED! 

SMI – MK4 and MK6
Re.: Installation of Remote Access HW upgrade Kit

This document describes the mechanical and electrical installation fo the modem into an MK4 or 
MK6 minilab

Related documentation
Description of Remote Access MKxx / 002

Necessary tools
Stadard service tools

Preconditions
1 Customer must provide a direct analog phone connection (not ISDN, not via local phone 

exchange). The phone number must be delivered to the service representative.

2 Customer must have signed the legal contract about Remote Access to the machine.

Scope of delivery
The upgrade kit P/N 380411 consists of the following parts:

Order
The upgrade kit P/N 380411 can be ordered according to the service contract which will contain the 
price of the upgrading kit. Please place your order at the attention of

Enclosures
Appendix A : Installation on MK4 (2 pages)
Appendix B : Installation on MK6 (2 pages)

Service Information
MK4, MK6

Number: MK46 / 001 
Date: August 14, 2006

# Items Description Part number
1 USB FAXmodem 56K (V.92) U.S. Robotics 12.00.16
1 Velcro ribbon L400 B30 black with buckle (not used for MK 6) 11.79.87
1 Marking set for modem and LAN cable 37.89.47
1 Modem cable JR12 6P/6C 1:1 3.0m 11.83.10
1 Connector RJ12 6P/6C, straight 11.83.11
1 Bag PE 200X340 97.90.48

Swiss Imaging Technologies AG
Barbara Bollmann
e-mail : barbara.bollmann@smi-grp.com
Fax : +41 44 842 22 82

Sincerely yours
Product Support
Swiss Imaging Technologies

MK46-001en-HWRemoteAccessUpkit.fm 4 of 6

Appendix B (2 pages)
Installation on MK6
1 Run down the machine by pressing the green button on the front panel.

2 Wait until the computer has been powered off.

3 Switch off the machine at the main switch.

4 Open the side panel to get access to the caminet below the computer.

5 Place the modem according to the following pictures.

6 Fasten the modem with the Velcro ribbon (P/N 11.79.87) to the cable loom.

7 There are two types of modems.The older version has 3 sockets and the new version has :
with 2 sockets on the rear.

At the modem with 3 sockets the one labelled Phone is not used.

8 Depending on the PC configuration different connections must be established:

9 Test at the customer site:
Dial the phone number of the machine: the modem must emit a whistling sound.
If the test fails, see Error handling below.

PC with Card-Reader upkit PC without Card-Reader upkit

Cable loom

Velcro ribbon

USB Telco USB Phone Telco
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Typographic issues
22 Typographic issues
What’s wrong (or at least bad practice) ?

Text sample Issue
Hecate est Iovis et Latonae filia, soror Apollinis. Est tricopor et triceps, magi-
carum artium magistra ac fascinationum praeses, cinctra latrantium canum turma; 
noctu stans in triviis vel prope sepulcra et ubi loca sunt caedibus contaminata. He-
cate est Iovis et Latonae filia, soror Apollinis. Est tricopor et triceps, magicarum 
artium magistra ac fascinationum praeses, cinctra latrantium canum turma; noctu 
stans in triviis vel prope sepulcra et ubi loca sunt caedibus contaminata.

1

Hecate est Iovis et Latonae filia, soror Apollinis. Est tricopor et triceps, magicarum artium magistra ac fa-
scinationum praeses, cinctra latrantium canum turma; noctu stans in triviis vel prope sepulcra et ubi loca sunt 
caedibus contaminata. Hecate est Iovis et Latonae filia, soror Apollinis. Est tricopor et triceps, magicarum 
artium magistra ac fascinationum praeses, cinctra latrantium canum turma; noctu stans in triviis vel prope 
sepulcra et ubi loca sunt caedibus contaminata.

2

The Hotplate 401 must be operated only under environ-
mental conditions as specified in the technical data for 
the ambient. The exhaust must always be in operation. The 
device must be switched off in case of malfunctioning 
exhaust.

3

Es ist nicht zu umgehen, dass solche
wörter manuell getrennt werden
müssen, da abenteurliche
buchstabenkombinationen an
silbengrenzen vorkommen.

Es ist nicht zu umgehen, dass solche 
wörter manuell getrennt werden 
müssen, da abenteurliche 
buchstabenkombinationen an 
silbengrenzen vorkommen.

4

Hecate est Iovis et Latonae filia, soror Apollinis. Est tricopor et triceps, magi-
carum artium magistra ac fascinationum praeses, cinctra latrantium canum 
turma; noctu stans in triviis vel prope sepulcra et ubi loca sunt caedib.

5

Diese drei Grenzen sind bei der Korrektur der Myopie im Vergleich zur Korrektur der 
Hyperopie unterschiedlich zu gewichten. Die Korrektur der Myopie ist ein seit vielen 
Jahren bekanntes Verfahren und soll demzufolge zuerst beleuchtet werden. In Abbil-
dung l ist der maximal erreichbare Visus gegenüber der Pupillengröße  dargestellt. Es 
zeigt sich, daß in einem für physiologische Bedingungen ausreichenden Spielraum von 
2 bis 4 mm Pupillengröße der theoretisch maximale Visus zwischen 2,0 und 4,0 liegt. 
Die retinale Auflösung würde wahrscheinlich einen Visus von maximal 2,5 - 3,0 erlau-
ben. Bei Pupillengrößen von 2,5 mm und weniger wird die maximale Auflösung jedoch 
durch diffraktive Effekte, das heißt durch Beugungserscheinungen, die das Licht am 
Pupillarsaum erfährt, begrenzt. Bei Pupillengrößen oberhalb von 4 mm unterstützt der 
Stiles-Crawford-Effekt (= geringere retinale Sensitivität für schräge Strahlenbündel aus 
den Randbezirken der Pupille) das Erkennen kleiner Muster, so daß theoretisch sogar 
ein Visus größer als 3,0, das heißt höher als die anatomische Auflösung der Retina, 
denkbar wäre. Aufgrund der optischen Brechfehler höherer Ordnung der transparen-
ten Medien beträgt jedoch der maximal erreichbare Visus bei Emrnetropie und einer 
Pupillengröße von mehr als 2 mm ungefähr 2,0. Dieser maximal erreichbare Visus wird 
durch Brechfehler nachhaltig beeinflußt. Bei einer Abweichung von der Emrnetropie 
von l dpt beträgt der maximal erreichbare Visus bei 2 mm Pupillengröße noch 1,0, bei 
4 mm Pupille nur noch ungefähr 0,6. Diese Diskrepanz zwischen maximal möglichem 
und tatsächlich erreichtem Visus ist bei größeren Brechungsfehlern wie beispielsweise 
5 dpt noch wesentlicher ausgeprägter, indem der maximale Visus bei 2 mm Pupille nur 
0,125 und bei 4 mm Pupille nur ungefähr 0,09 beträgt. Mittels Korrektur der ...

6
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Typographic issues
22.1 Possible answers to the questions
1 Lines are far to long.

A rule of thumb states: line length in cm is approximately 
equal to font height in pt. That is, for a 10 pt font use 10 
- 11 cm wide lines.

2 Too small font size for running text.
In German this is called Konsultationsgrösse, which 
means that small font sizes should only be used for text 
being consulted optionally (such as footnotes or marginal 
remarks), not for ordinary reading

3 Inadequate font
Technical text requires a ‘technical’ appearance. A script 
font is good for a diary or poems.

4 Rivers and blanks
Narrow columns and/or long words without decent 
hyphenation will create an ugly presentation of justified 
text. Especially German with the long compound words 
require careful treatment of the hyphenation. Otherwise 
you will get words like the famous Urin-stinkt (Ur-
instinkt). In general, prefer flush right (left adjusted) text 
over justified text. It presents even word spacing.

5 Font with small ascenders
Fonts with a small difference of caps height and x-height 
(the height of the lower case items) can not be read flu-
ently. It will become difficult to distinguish between i and 
l and others. Prefer a font with good proportions.

6 This text is a nightmare, although it was written by a 
famous Swiss ophthalmologist in Bern. I was requested to 
translate it into English. The greatest issue was to under-
stand the German… See my interpretation on the follow-
ing page (the full text spans 4 pages).
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Typographic issues
22.2 Interpretation of the German text 
from page 35

Summary

Present knowledge regarding the physiological -optical , biomechanical  and technical  l imi tations of  re-
f ractive laser surgery of  the cornea recommends l imi ts of  maximum correction of  myopia (6 dpt i f  done
by PRK, 10 dpt i f  done by LASIK), hyperopia (5 dpt) and corneal  astigmatism (3 dpt). Individual  factors
may increase or decrease these l imi ts in selected cases. M ajor ref ractive corrections may not be achievable
on the cornea alone but may involve the enti re optical  System of  the eye.

OPHTHALMO-CHIRURGIE 13: 139-145 (2001)

Most refractive eye diseases can be corrected
or at least reduced with refractive laser sur-
gery. There are, however, three basic limita-
tions:

1 Physiological- optical limits:
− minimal size of ablation zone which dif-

fers between day and night
− depth of the ablation zone (which is cor-

related to the size)
− configuration of the ablation zone (e.g.

multizone ablation).

2 Biomechanical limits:
− Reduction of mechanical stability of the

cornea which may lead to iatrotenic ker-
atectasia

3 Technical precision of the ablation:
− Hydration of cornea
− Induced elastic vibrations
− Eye movements of the patient during la-

ser treatment

Size of the ablation zone and scotopic width of
the pupil are the most important limiting factors
for maximum sight in the dark

Pupil size varies naturally from  2 to 4 mm.
Hence the theoretcally maximum visual acuity
will be 2.0 to 4.0. The retinal resolution proba-
bly could provide a maximum visual acuity of
2.5 to 3.0. With pupil diameters of 2.5 mm or
less this maximum resolution is limited by dif-
fractive effects. These are produced by incli-
nations of the light at the pupillary rim.

With pupil sizes larger than 4 mm the Stiles-
Crawford effect (reduced sensitivity of the
retina for oblique rays) supports the percep-
tion of small patterns. This effect results in a
theoretical visual acuity larger than 3.0 (higher
than the physiological resolution of the retina).

Due to the nonlinear effect of high order re-
fractive errors of the transparent media, theo-
retical and manifest visual acuity are not cor-
related:

emme-
tropy

1 dpt 5 dpt

pupil
diameter

> 2.0 mm  2 mm 4 mm 2mm 4mm

maximum
possible
visual acuity

2.0 1.0 0.125

real
visual acuity

approx.
0.6

0.09

By means of refractive laser surgery the optical
conditions of the eye are intended to be cor-
rected towards emmetropy. However, the ab-
lation zone is of major importance. Using a
common ablation zone of 4 mm diameter vis-
ual acuity of 2.0 may be reached at emme-
tropy. If the pupil is dilated (common in sco-
topic conditions), the zone of full refractive
correction and the transition zone overlap.
Hence the mani-fest visual acuity decreases at
pupil sizes greater than 4 mm (see yellow line
in fig. 2).

Fig. 1: Physiological-optical limits of the maximum possible
visual acuity at ideal conditions. The maximum possible visual
acuity varies as a function of the pupil size. It is supported by
the Stiles-Crawford effect and limited by the maximum retinal
resolution, diffractive effects and aberrations of lower and
higher order.
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